Mitel SX-2000 PIMG Integration Guide for
Cisco Unity Connection 1.2

Revised October 12, 2007

This document provides instructions for integrating the Mitel SX-2000 phone system with Cisco Unity
Connection by using the Intel NetStructure PBX-IP Media Gateway (PIMG).

Integration Tasks

Before doing the following tasks to integrate Cisco Unity Connection with the Mitel SX-2000 phone
system by using PIMG units, confirm that the Cisco Unity Connection server is ready for the integration
by completing the applicable tasks in the Cisco Unity Connection Installation Guide.

The following task list describes the process for creating an integration.

Task List to Create the Integration

st
CISCO.

Use the following task list to set up a new integration with the Mitel SX-2000 phone system. If you are
installing a new Cisco Unity Connection server by using the Cisco Unity Connection Installation Guide,
you may have already completed some of the following tasks.

1.

Review the system and equipment requirements to confirm that all phone system and Cisco Unity
Connection server requirements have been met. See the “Requirements” section on page 2.

Plan how the voice messaging ports will be used by Cisco Unity Connection. See the “Planning How
the Voice Messaging Ports Will Be Used by Cisco Unity Connection” section on page 4.

Program the Mitel SX-2000 phone system and extensions. See the “Programming the Mitel SX-2000
Phone System” section on page 6.

Set up the PIMG units. See the “Setting Up the PIMG Units” section on page 8.

Add a port group template for the Mitel SX-2000 phone system. See the “Adding a Port Group
Template for the Mitel SX-2000 Phone System” section on page 15.

Create the integration. See the “Creating a New Integration with the Mitel SX-2000 Phone System”
section on page 16.
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1.
8.

Test the integration. See the “Testing the Integration” section on page 18.

If this integration is a second or subsequent integration, add the applicable new user templates for
the new phone system. See the (Multiple Integrations Only) Adding New User Templates, page 22.

Requirements

The Mitel SX-2000 integration supports configurations of the following components:

Phone System

Mitel SX-2000 phone system.

One or more of the applicable PIMG units. For details, refer to the “Supported Circuit-Switched
Phone System Integrations” section of Cisco Unity Connection System Requirements, and
Supported Hardware and Software at
http://www.cisco.com/en/US/products/ps6509/prod_installation_guides_list.html.

The voice messaging ports in the phone system connected by digital lines to the ports on the PIMG
units.

We recommend that you connect the voice messaging ports on the phone system to the ports on the
PIMG units in a planned manner to simplify troubleshooting. For example, the first phone system
voice messaging port connects to the first port on the first PIMG unit, the second phone system voice
messaging port connects to the second port on the first PIMG unit, and so on.

The PIMG units connected to the same LAN or WAN that Cisco Unity Connection is connected to.
If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

- For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

— For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

— No network devices that implement network address translation (NAT).
— A maximum 200 ms network latency.

The phone system ready for the integration, as described in the documentation for the phone system.

Cisco Unity Connection Server

Cisco Unity Connection installed and ready for the integration, as described in the Cisco Unity
Connection Installation Guide at
http://www.cisco.com/en/US/products/ps6509/prod_installation_guides_list.html.

A license that enables the applicable number of voice messaging ports.
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Integration Description

Integration Description

The Mitel SX-2000 integration sends call information and voice connections through the digital lines,
which connect the phone system to the PIMG units. The PIMG units communicate with the Cisco Unity
Connection server through the LAN or WAN by using Session Initiation Protocol (SIP). Figure 1 shows

the required connections.

Figure 1 Connections Between the Phone System and Cisco Unity Connection
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Call Information

The phone system sends the following information with forwarded calls:

e The extension of the called party

¢ The extension of the calling party (for internal calls) or the phone number of the calling party (if it
is an external call and the system uses caller ID)

e The reason for the forward (the extension is busy, does not answer, or is set to forward all calls)

Cisco Unity Connection uses this information to answer the call appropriately. For example, a call
forwarded to Cisco Unity Connection is answered with the personal greeting of the user. If the phone
system routes the call to Cisco Unity Connection without this information, Cisco Unity Connection

answers with the opening greeting.

Integration Functionality

The Mitel SX-2000 integration with Cisco Unity Connection provides the following features:
e (Call forward to personal greeting
e C(Call forward to busy greeting

e Caller ID

e Easy message access (a subscriber can retrieve messages without entering an ID because
Cisco Unity Connection identifies the subscriber based on the extension from which the call

originated; a password may be required)

Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2
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e Identified subscriber messaging (Cisco Unity Connection identifies the subscriber who leaves a
message during a forwarded internal call, based on the extension from which the call originated)

e Message waiting indication (MWI)

Integrations with Multiple Phone Systems

Cisco Unity Connection can be integrated with multiple phone systems at one time. For information on
and instructions for integrating Cisco Unity Connection with multiple phone systems, refer to the
Multiple Phone System Integration Guide at
http://www.cisco.com/en/US/products/ps6509/products_installation_and_configuration_guides_list.ht
ml.

Planning How the Voice Messaging Ports Will Be Used by
Cisco Unity Connection

Before programming the phone system, you need to plan how the voice messaging ports will be used by
Cisco Unity Connection. The following considerations will affect the programming for the phone system
(for example, setting up the hunt group or call forwarding for the voice messaging ports):

e The number of voice messaging ports installed.
e The number of voice messaging ports that will answer calls.

e The number of voice messaging ports that will only dial out, for example, to send message
notification, to set message waiting indicators (MWIs), and to make telephone record and playback
(TRAP) connections.

The following table describes the voice messaging port settings in Cisco Unity Connection that can be
set on Telephony Integrations > Port of Cisco Unity Connection Administration.

Table 1 Settings for the Voice Messaging Ports
Field Considerations
Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port get
a ringing tone but are not answered. Typically, the port is disabled only by the installer
during testing.

Extension Enter the extension for the port as assigned on the phone system.

Answer Calls Check this check box to designate the port for answering calls. These calls can be
incoming calls from unidentified callers or from users.

Perform Message Notification Check this check box to designate the port for notifying users of messages. Assign
Perform Message Notification to the least busy ports.

Send MWI Requests Check this check box to designate the port for turning MWIs on and off. Assign Send MWI

Requests to the least busy ports.

Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2
n. 0L-12479-04 |


http://www.cisco.com/en/US/products/ps6509/products_installation_and_configuration_guides_list.html
http://www.cisco.com/en/US/products/ps6509/products_installation_and_configuration_guides_list.html

| Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2

Planning How the Voice Messaging Ports Will Be Used by Cisco Unity Connection I

Table 1 Settings for the Voice Messaging Ports (continued)
Field Considerations
Allow TRAP Connections Check this check box so that users can use the port for recording and playback through the

phone in Cisco Unity Connection web applications. Assign Allow TRAP Connections to
the least busy ports.

Outgoing Hunt Order

Enter the priority order in which Cisco Unity Connection will use the ports when dialing
out (for example, if the Perform Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest numbers are used first. However,
when multiple ports have the same Outgoing Hunt Order number, Cisco Unity Connection
will use the port that has been idle the longest.

The Number of Voice Messaging Ports to Install

The number of voice messaging ports to install depends on numerous factors, including:
e The number of calls Cisco Unity Connection will answer when call traffic is at its peak.
e The expected length of each message that callers will record and that users will listen to.
e The number of users.
¢ The number of ports that will be set to dial out only.
e The number of calls made for message notification.
e The number of MWIs that will be activated when call traffic is at its peak.

e The number of TRAP connections needed when call traffic is at its peak. (TRAP connections are
used by Cisco Unity Connection web applications to play back and record over the phone.)

e The number of calls that will use the automated attendant and call handlers when call traffic is at its
peak.

It is best to install only the number of voice messaging ports that are needed so that system resources are
not allocated to unused ports.

The Number of Voice Messaging Ports That Will Answer Calls

The calls that the voice messaging ports answer can be incoming calls from unidentified callers or from
users. Typically, the voice messaging ports that answer calls are the busiest.

You can set voice messaging ports to both answer calls and to dial out (for example, to send message
notifications). However, when the voice messaging ports perform more than one function and are very
active (for example, answering many calls), the other functions may be delayed until the voice messaging
port is free (for example, message notifications cannot be sent until there are fewer calls to answer). For
best performance, dedicate certain voice messaging ports for only answering incoming calls, and
dedicate other ports for only dialing out. Separating these port functions eliminates the possibility of a
collision, in which an incoming call arrives on a port at the same time that Cisco Unity Connection takes
the port off-hook to dial out.

The Number of Voice Messaging Ports That Will Only Dial Out, and Not Answer Calls

Ports that will only dial out and will not answer calls can do one or more of the following:
¢ Notify users by phone, pager, or e-mail of messages that have arrived.
e Turn MWIs on and off for user extensions.

e Make a TRAP connection so that users can use the phone as a recording and playback device in
Cisco Unity Connection web applications.
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A

Typically, these voice messaging ports are the least busy ports.

Caution

In programming the phone system, do not send calls to voice messaging ports in Cisco Unity Connection
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice
messaging port is set only to Send MWI Requests, do not send calls to it.

Preparing for Programming the Phone System

Record your decisions about the voice messaging ports to guide you in programming the phone system.

Programming the Mitel SX-2000 Phone System

A

If you use programming options other than those supplied in the following procedure, the performance
of the integration may be affected.

Caution

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6
Step 7

In programming the phone system, do not send calls to voice messaging ports in Cisco Unity Connection
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice
messaging port is set only to Dialout MWI, do not send calls to it.

Do the applicable procedure.

To Program the Mitel SX-2000 Phone System

On the phone system console, go to the Main Forms screen, and click Multiline Set Forms.
On the Multiline Set Forms screen, click Multiline Set Assignment.
On the Multiline Set Assignment screen, click DNI Circuit Assignment.

On the DNI Circuit Assignment screen, enter the following options.

Table 2 DNI Circuit Assignment Options
Field Setting

Cabinet 2

Shelf 1

Slot 7

Circuit 4

Card Type DNI Line
Device Type: Channel #1 Superset 430

Return to the Multiline Set Forms screen.
On the Multiline Set Forms screen, click Multiline Set Key Assignment.

On the Multiline Set Key Assignment screen, enter the following options.

Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2
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Table 3

Multiline Set Key Assignment Options

Programming the Mitel SX-2000 Phone System 1l

Field

Setting

Prime Directory Number

<the first directory number>

Key Number: 2 not assigned
Key Number: 3 not assigned
Key Number: 4 not assigned
Key Number: 5 not assigned
Key Number: 6 not assigned
Key Number: 7 not assigned
Key Number: 8 not assigned
Key Number: 9 not assigned
Key Number: 10 not assigned
Key Number: 11 not assigned
Step8  Return to the Form Groups screen.
Step9  On the Form Groups screen, click Group Forms.
Step10  On the Group Forms screen, click Hunt Group Assignment.
Step11  On the Hunt Group Assignment screen, enter the following options.
Table 4 Hunt Group Assignment Options
Field Setting
Pilot Number <the pilot number for Cisco Unity>
Name IP gateway hunt
Hunt Mode <the hunt mode you want to use; for example select “Circular”>
Step12 In the Hunt Group Assignment table of the Hunt Group Assignment screen, assign the directory number
for each port on the PIMG units connected to the phone system as follows.
Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2
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Table 5 Hunt Group Assignment Table

Member Directory Number Name

1 <the prime directory number> IP gateway Port 1

2 <the second directory number> IP gateway Port 2

3 <the third directory number> IP gateway Port 3

4 <the next directory number> IP gateway Port 4

5 <the next directory number> IP gateway Port 5

6 <the next directory number> IP gateway Port 6

7 <the next directory number> IP gateway Port 7

8 <the next directory number> IP gateway Port 8
<additional directory numbers>

<last member> <the last directory number> IP gateway Port <n>

Setting Up the PIMG Units

Step 1

Step 2

Step 3
Step 4

Do the following procedures to set up the PIMG units that are connected to the Mitel SX-2000 phone
system.

These procedures require that the following tasks have already been completed:
e The phone system is connected to the PIMG units by using digital lines.
e The PIMG units are ready to be connected to the LAN or WAN.
e The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default
values of all fields, see the documentation for the PIMG unit.

To Download the PIMG Firmware Update Files for Mitel Digital PIMG Units

On a Windows workstation that will have access to the PIMG units, open a web browser and go to the
Cisco Unity PIMG Software Download page at
http://www.cisco.com/cgi-bin/tablebuild.pl/unity-PIMG.

~

Note  To access the software download page, you must be logged on to Cisco.com as a registered user.

On the Cisco Unity PIMG Software Download page, click the most recent version of the firmware for
digital Mitel PIMG units.

On the Details page, click Next.
On the Document page, click Accept.

Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2
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Step 5
Step 6
Step 7

Step 8

Step 9
Step 10
Step 11

Step 1

Step 2
Step 3
Step 4

Step 5
Step 6
Step 7
Step 8

Step 9
Step 10
Step 11

Setting Up the PIMG Units 1l

In the Enter Network Password dialog box, enter your user name and password, then click OK.
In the File Download dialog box, click Save.

In the Save As dialog box, browse to the Windows workstation that will have access the PIMG units,
browse to a directory where you want to save the file, and click Save.

In the Download Complete dialog box, click Open. The window for extracting the PIMG firmware
update files appears.

Click Extract.
In the Extract dialog box, browse to the directory where you want the extracted files, and click Extract.

Close the window for the extracting application.

To Set Up the Mitel PIMG Units

On the Windows workstation, add a temporary route to enable access to the PIMG units.
a. On the Windows Start menu, click Run.
b. Enter cmd, and press Enter. The Command Prompt window appears.

c. At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press
Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add
10.12.13.74<space>198.1.3.25” in the Command Prompt window.

d. Close the Command Prompt window.
Connect a PIMG unit to the network.
In the web browser, go to http://10.12.13.74.

On the System Login page, enter the following case-sensitive settings.

Table 6 System Login Page Settings
Field Setting

Username admin

Password IpodAdmin

Click Log On.
On the Configure menu, click Upgrade.
On the Upgrade page, click Browse.

In the Choose File dialog box, browse to the directory on the Windows workstation that has the extracted
PIMG firmware update files.

Click Mtl_<xx>.app (where <xx> is multiple digits), and click Open.
On the Upgrade page, click Install.
After the file is installed, a message prompting you to restart the PIMG unit appears. Click Cancel.

| oL-12479-00

Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2 g



Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2 |

Il Setting Up the PIMG Units

Step 12

Step 13
Step 14
Step 15
Step 16
Step 17
Step 18
Step 19
Step 20

Step 21
Step 22
Step 23

Step 24
Step 25
Step 26

A

Caution Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if
the file installation fails. Restarting the PIMG unit at this step may prevent the PIMG unit
from functioning correctly.

Repeat Step 6 through Step 11 for each of the following files:
e Mitl_<xx>.fsh
e Run_<xx>FskEcho.dsp
e Mitl<xx>.Ica
On the Configure menu, click Upgrade.
On the Upgrade page, click Browse.
In the Choose File dialog box, browse to the file MTLDNI_Cfg_Mitel.ini.
Click MTLDNI_Cfg_Mitel.ini, and click Open.
On the Upgrade page, click Install.
After the file is installed, a message prompting you to restart the PIMG unit appears. Click OK.
In the web browser, go to http://10.12.13.74.

On the System Login page, enter the following case-sensitive settings.

Table 7 System Login Page Settings
Field Setting

Username admin

Password IpodAdmin

Click Log On.

On the Configure menu, click Password.

On the Password page, enter the following settings.

Table 8 Password Page Settings
Field Setting
Old Password IpodAdmin

(This setting is case sensitive.)

New Password <your new password>

(This setting is case sensitive.)

Confirm Password <your new password>

(This setting is case sensitive.)

Click Change.
On the Configure menu, click System.

On the System page, enter the following settings.

Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2
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Step 27
Step 28
Step 29
Step 30

Step 31
Step 32
Step 33

Setting Up the PIMG Units

Table 9 System Page Settings
Field Setting
Operating Mode SIP

Telephony Switch Type

(This setting does not apply.)

PCM Coding

uLaw

Click Apply Changes.

On the Configure menu,

click Gateway.

On the Gateway page, click the Gateway Routing tab.

On the Gateway Routing tab, enter the following settings.

Table 10 Gateway Routing Tab Settings

Field Setting

Fault Tolerance No

Enabled

Load Balancing No

Enabled

VoIP Endpoint ID: <the IP address of the Cisco Unity Connection server>
1

VoIP Endpoint ID: <blank>

2

Click Apply Changes.

Click the Gateway Advanced tab.

On the Gateway Advanced tab, enter the following settings.

Table 11 Gateway Advanced Tab Settings
Field Setting
Call Connect Mode OnAnswer

Destination for
Unroutable PBX Calls

<the extension of an attendant who will receive calls to Cisco Unity
Connection that are unanswered>

Turn MWI On FAC #51
Turn MWI Off FAC #52
Wait for Yes
Ringback/Connect on

Blind Transfer

Hunt Group Extension

<the pilot number for the Cisco Unity Connection voice messaging ports>

Audio Compression

Click the preferred codec for audio compression:
e G.711 Only
* G.729 A Preferred

| oL-12479-00
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Table 11 Gateway Advanced Tab Settings (continued)
Field Setting
Signaling Digit Relay |Off
Mode
Voice Activity Off
Detection
Frame Size Click the applicable setting:
e G.711—20
e G.729a—10

A

Caution  Failure to use the correct setting will result in recorded messages
containing nothing but silence.

Frames Per Packet Click the applicable setting:
e G.711—1
e G.729a—2

A

Caution  Failure to use the correct setting will result in recorded messages
containing nothing but silence.

Call Control QOS (PIMG units connect only to a LAN) 0
Byte (PIMG units connect to a WAN) 104

S,

Note  For details on the setting for a LAN, see the caveat CSCsb96387.

RTP QOS Byte (PIMG units connect only to a LAN) 0
(PIMG units connect to a WAN) 184

~

Note  For details on the setting for a LAN, see the caveat CSCsb96387.

Step34 Click Apply Changes.
Step35 Click the Gateway Capabilities tab.
Step36 Depending on how you have planned to use the voice messaging ports, click the applicable setting for

each port in the Telephony Port Capability column.

Table 12 Gateway Capabilities Tab Settings

Telephony Port Capability Settings |Voice Messaging Port Usage

Calls-Only The port will answer incoming calls only and will not dial out
(for example, to set MWIs or send message notifications).
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Step 37
Step 38
Step 39

Step 40
Step #1
Step 42

Setting Up the PIMG Units 1l

Table 12 Gateway Capabilities Tab Settings (continued)

Telephony Port Capability Settings |Voice Messaging Port Usage

MWIs-Only The port will dial out only (for example, to set MWIs or send
message notifications) and will not answer incoming calls.

Both The port will answer incoming calls and will also dial out (for
example, to set MWIs or send message notifications).

A

Caution  In setting up the PIMG unit, do not send calls to ports in Cisco Unity that cannot answer calls
(voice messaging ports that are not set to Answer Calls). For example, if a voice messaging
port is set only to Dialout MWI, do not send calls to it. Otherwise the integration will not
function correctly.

If a port in Cisco Unity Connection is disabled, click No in the Telephony Port Enabled column for the
corresponding port on this tab. Note that changing a setting in the Telephony Port Enabled column
requires restarting the PIMG unit.

Click Apply Changes.
On the Configure menu, click SIP.
On the SIP page, enter the following settings.

Table 13 SIP Page Settings

Field Setting

Host and Domain Name <the domain name of the PIMG unit>
Server Port 5060

Primary Proxy Server Address |<the IP address of the Cisco Unity Connection server>

Primary Proxy Server Port 5060

(When you configure more than one PIMG unit, increase this setting
by 1 for each successive unit. For example, unit 2 will be 5061,
unit 3 will be 5062, and so on.)

Proxy Query Interval 10
T1 Time 400
T2 Time 3000

Click Apply Changes.
On the Configure menu, click IP.
On the IP page, enter the following settings.
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Step 43
Step 44
Step 45

Step 46

Step 47

Step 48

Step 49

Step 50

Step 51

Table 14 IP Page Settings
Field Setting
Client IP Address <the new IP address you want to use for the PIMG unit>

(This is the IP address that you will enter in Cisco Unity Connection
Administration when you create the integration.)

Client Subnet Mask <the new subnet mask, if the subnet mask is different from the default IP

address>
Default Network <the IP address of the default network gateway router that the PIMG units will
Gateway Address use>
BOOTP Enabled No

Click Apply Changes.
On the Configure menu, click Tones.

On the Tones page, click the Learn tab.

A

Caution  Destination addresses cannot be duplicated in the same session. Otherwise, the process for
learning tones will not succeed. If you do not have enough available phones to learn all the
tones at one time, you can run multiple sessions to learn tones individually by checking or
unchecking the applicable Acquire Tone check boxes.

On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and leave
the Destination Address field blank.

On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and do
the following substeps to verify that the tone is correct.

a. From a available phone, call a second phone.

b. Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c¢. From a third phone, dial one of the busy phones.

d. Confirm that you hear a busy tone.

e. Hang up the third phone but leave the handsets for the other two phones off.

On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed
in Step 47c. from the third phone.

On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is
checked and do the following substeps to verify that the tone is correct.

a. From an available phone, dial an extension that does not exist.
b. Confirm that you hear the reorder or error tone.
c¢. Hang up the phone.

On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that you
dialed in Step 49a.

On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked
and do the following substeps to verify that the tone is correct.

a. From an available phone, dial an extension that does exist

Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2
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Step 52

Step 53

Step 54
Step 55
Step 56
Step 57
Step 58
Step 59

Adding a Port Group Template for the Mitel SX-2000 Phone System Il

b. Confirm that you hear the ringback tone.
c¢. Hang up the phone.

On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you
dialed in Step 51a.

Click Learn.

~

Note  When running learn tones, the PIMG unit will restart after learning the first tone. For details, see
the caveat CSCsh53791.

When the process is complete, check the check box for each newly learned tone and click Apply.
Hang up the phones that you used in Step 47.

On the Configure menu, click Restart.

On the Restart page, click Restart Unit Now.

When the PIMG unit has restarted, in the View menu, click Refresh.

Repeat Step 2 through Step 58 on all remaining PIMG units.

Adding a Port Group Template for the Mitel SX-2000 Phone
System

Step 1

Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Step 9

Before creating the integration with the Mitel SX-2000 phone system, you must add a port group
template for this phone system.

Do the following procedure.

To Add a Port Group Template for the Mitel SX-2000 Phone System

On the Cisco Unity Connection server, open a web browser and go to the Cisco Unity PIMG Software
Download page at http://www.cisco.com/cgi-bin/tablebuild.pl/unity-PIMG.

S

Note  To access the software download page, you must be logged on to Cisco.com as a registered user.

On the Cisco Unity PIMG Software Download page, click Unity_Connection_Mitel_patch.zip.
On the Details page, click Next.

On the Document page, click Accept.

In the Enter Network Password dialog box, enter your user name and password, then click OK.
In the File Download dialog box, click Save.

In the Save As dialog box, browse to a directory where you want to save the file, and click Save.

In the Download Complete dialog box, click Open. The window for extracting the PIMG firmware
update files appears.

Click Extract.
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Step 10
Step 11
Step 12
Step 13

Step 14
Step 15
Step 16

In the Extract dialog box, browse to the directory where you want the extracted file, and click Extract.
Close the window for the extracting application.
On the Windows Start menu, click Programs > Accessories > Command Prompt.

In the Command Prompt window, enter osql -E -S .\ciscounity /i <path to
directory>\Unity_Connection_Mitel_patch.sql /o AddIntegration.log, where “<path to directory>"
is the path to the directory where you saved the file that you downloaded.

Press Enter.
Close the Command Prompt window.

Delete the Unity_Connection_Mitel_patch.zip and the Unity_Connection_Mitel_patch.sql files.

Creating a New Integration with the Mitel SX-2000 Phone

System

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Step 7

Step 8

After ensuring that the Mitel SX-2000 phone system and Cisco Unity Connection are ready for the
integration, do the following procedures to set up the integration and to enter the port settings.

To Create an Integration

Log on to Cisco Unity Connection Administration.
In Cisco Unity Connection Administration, expand Telephony Integrations, then click Phone System.

On the Search Phone Systems page, on the Phone System menu, click New Phone System. The Phone
System Integration Wizard appears.

On the Select Phone System Manufacturer page, in the Manufacturer field, click Mitel and click Next.
On the Select Phone System Model page, in the Model field, click Mitel SX-2000 and click Next.

On the Set Up Phone System page, in the Phone System Name field, accept the default name or enter the
descriptive name that you want, and click Next.

On the Select Port Group Template page, in the Port Group Template field, click Mitel PIMG to Mitel
SX-2000 and click Next.

On the Set Up Port Group page, enter the following settings and click Next.

Table 15 Settings for the Set Up Port Group Page
Field Setting
Port Group Name <a descriptive name for the port group; accept the default name or enter the

name that you want>

Number of Ports 8

(If you want to use fewer than eight voice messaging ports, enter the
number of voice messaging ports that you want to use on this PIMG unit.)

IP Address or Host Name |<the IP address of the PIMG unit that you are integrating with Cisco Unity
Connection>

Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2
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Table 15 Settings for the Set Up Port Group Page (continued)

Field Setting

Test Address Click this button to test the IP address that you entered. The results of the
test appear in the field to the right of the button.

Port <the SIP port of the PIMG unit that Cisco Unity Connection will connect

to; we recommend that you use the default setting>

A

Caution  This setting must match the setting for the Server Port field of the
PIMG unit. Otherwise the integration will not function correctly.

Step9  On the Confirm Phone System Settings page, confirm the settings that you have entered and click Finish.

Step10  On the Phone System Creation Summary page, click Close.

Step11  In Cisco Unity Connection Administration, expand Telephony Integrations, then click Port.

Step12  On the Search Ports page, click the display name of the first voice messaging port that you created for
this phone system integration.

~

Note By default, the display names for the voice messaging ports are composed of the port group
display name followed by incrementing numbers.

Step13  On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following
table are the ones that you can change.

Table 16 Settings for the Voice Messaging Ports

Field Considerations

Enabled Check this check box to enable the port. The port is enabled during normal operation.
Uncheck this check box to disable the port. When the port is disabled, calls to the port get
a ringing tone but are not answered. Typically, the port is disabled only by the installer
during testing.

Extension Enter the extension for the port as assigned on the phone system.

Answer Calls

Check this check box to designate the port for answering calls. These calls can be
incoming calls from unidentified callers or from users.

Perform Message Notification

Check this check box to designate the port for notifying users of messages. Assign
Perform Message Notification to the least busy ports.

Send MWI Requests

Check this check box to designate the port for turning MWIs on and off. Assign Send MWI
Requests to the least busy ports.

Allow TRAP Connections

Check this check box so that users can use the port for recording and playback through the
phone in Cisco Unity Connection web applications. Assign Allow TRAP Connections to
the least busy ports.

Outgoing Hunt Order

Enter the priority order in which Cisco Unity Connection will use the ports when dialing
out (for example, if the Perform Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest numbers are used first. However,
when multiple ports have the same Outgoing Hunt Order number, Cisco Unity Connection
will use the port that has been idle the longest.
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Step 14
Step 15
Step 16
Step 17

Step 18

Step 19

Step 20
Step 21

Step 22
Step 23

Step 24
Step 25

Click Save.
Click Next.
Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.

If another phone system integration exists, in Cisco Unity Connection Administration, expand
Telephony Integrations, then click Trunk. Otherwise, skip to Step 21.

On the Search Phone System Trunks page, on the Phone System Trunk menu, click New Phone System
Trunk.

On the New Phone System Trunk page, enter the following settings for the phone system trunk and click
Save.

Table 17 Settings for the Phone System Trunk

Field Setting

From Phone System |<the display name of the phone system that you are creating a trunk for>

To Phone System <the display name of the previously existing phone system that the trunk will
connect to>

Trunk Access Code |<the extra digits that Cisco Unity Connection must dial to transfer calls
through the gateway to extensions on the previously existing phone system>

Repeat Step 18 and Step 19 for all remaining phone system trunks that you want to create.

If prompted to restart Cisco Unity Connection, in the Windows task bar, right-click the Cisco Unity
Connection icon and click Restart > Voice Processing Server Role.

When prompted to confirm stopping the Voice Processing server role, click Yes.

In Cisco Unity Connection Administration, in the Related Links drop-down list, click Check Telephony
Configuration and click Go to confirm the phone system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with
troubleshooting steps. After correcting the problems, test the connection again.

In the Task Execution Results window, click Close.

Log off Cisco Unity Connection Administration.

Testing the Integration

Step 1

To test whether Cisco Unity Connection and the phone system are integrated correctly, do the following
procedures in the order listed.

If any of the steps indicate a failure, refer to the following documentation as applicable:
e The installation guide for the phone system.

e The setup information earlier in this guide.

To Set Up the Test Configuration

Set up two test extensions (Phone 1 and Phone 2) on the same phone system that Cisco Unity Connection
is connected to.

Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2
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Step 2

Step 3

Step 4
Step 5

Step 6
Step 7
Step 8

Step 9

Step 10
Step 11
Step 12

Step 13

Step 14
Step 15
Step 16

Testing the Integration W

Set Phone 1 to forward calls to the Cisco Unity Connection pilot number when calls are not answered.

A

Caution

The phone system must forward calls to the Cisco Unity Connection pilot number in no fewer
than four rings. Otherwise, the test may fail.

To create a test user for testing, in Cisco Unity Connection Administration, expand Users, then click
Users.

On the Search Users page, on the User menu, click New User.

On the New User page, enter the following settings.

Table 18 Settings for the New User Page

Field Setting

User Type User with Voice Mailbox
Based on Template <the applicable user template>
Alias testuser

First Name Test

Last Name User

Display Name Test User

Extension <the extension of Phone 1>

Click Save.
On the Edit User Basics page, in the Voice Name field, record a voice name for the test user.

In the Phone System field, confirm that the phone system selected is the phone system that Phone 1 is
connected to.

Uncheck the Set for Self-enrollment at Next Login check box.
Click Save.
On the Edit menu, click Message Waiting Indicators.

On the Message Waiting Indicators page, click the message waiting indicator. If no message waiting
indication is in the table, click Add New.

On the Edit Message Waiting Indicator page, enter the following settings.

Table 19 Settings for the Edit MWI Page
Field Setting
Enabled Check this check box to enable MWIs for the test user.

Display Name Accept the default or enter a different name.

Check this check box to enable MWIs on Phone 1.

Inherit User’s
Extension

Click Save.
On the Edit menu, click Transfer Options.

On the Transfer Options page, click the active option.

Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2

| oL-12479-00



Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2 |

I Testing the Integration

Step 17

Step 18
Step 19
Step 20

Step 21
Step 22

Step 23

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Step 7
Step 8
Step 9

Step 10

Step 1
Step 2

On the Edit Transfer Option page, under Transfer Action, click the Extension option and enter the
extension of Phone 1.

In the Transfer Type field, click Release to Switch.
Click Save.
Minimize the Cisco Unity Connection Administration window.

Do not close the Cisco Unity Connection Administration window because you will use it again in a later
procedure.

On the Cisco Unity Connection desktop, double-click the Tools Depot icon.

In the left pane of the Tools Depot window, expand Switch Integration Tools, then double-click Port
Status Monitor. The Port Status Monitor window appears.

On the Ports menu, click Start All, and arrange the port monitors so that you can notice which port will
handle the calls that you will make.

To Test an External Call with Release Transfer

From Phone 2, enter the access code necessary to get an outside line, then enter the number outside
callers use to dial directly to Cisco Unity Connection.

In the Port Status Monitor, note which port handles this call.

When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting
means that the port is configured correctly.

Confirm that Phone 1 rings and that you hear a ringback tone on Phone 2. Hearing a ringback tone means
that Cisco Unity Connection correctly released the call and transferred it to Phone 1.

Leaving Phone 1 unanswered, confirm that the state of the port handling the call changes to “Idle.” This
state means that release transfer is successful.

Confirm that, after the number of rings that the phone system is set to wait, the call is forwarded to
Cisco Unity Connection and that you hear the greeting for the test user. Hearing the greeting means that
the phone system forwarded the unanswered call and the call-forward information to Cisco Unity
Connection, which correctly interpreted the information.

On the Port Status Monitor, note which port handles this call.
Leave a message for the test user and hang up Phone 2.

In the Port Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This
state means that the port was successfully released when the call ended.

Confirm that the MWI on Phone 1 is activated. The activated MWI means that the phone system and
Cisco Unity Connection are successfully integrated for turning on MWTIs.

To Test Listening to Messages

From Phone 1, enter the internal pilot number for Cisco Unity Connection.

When asked for your password, enter the password for the test user. Hearing the request for your
password means that the phone system sent the necessary call information to Cisco Unity Connection,
which correctly interpreted the information.

Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2
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Step 3

Step 4
Step 5
Step 6

Step 7
Step 8

Step 1

Step 2
Step 3
Step 4

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Step 7
Step 8

Step 9

Testing the Integration W

Confirm that you hear the recorded voice name for the test user (if you did not record a voice name for
the test user, you will hear the extension number for Phone 1). Hearing the voice name means that
Cisco Unity Connection correctly identified the user by the extension.

Listen to the message.
After listening to the message, delete the message.

Confirm that the MWI on Phone 1 is deactivated. The deactivated MWI means that the phone system and
Cisco Unity Connection are successfully integrated for turning off MWIs.

Hang up Phone 1.

On the Port Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This
state means that the port was successfully released when the call ended.

To Set Up Supervised Transfer on Cisco Unity Connection

In Cisco Unity Connection Administration, on the Edit Transfer Option page for the test user, in the
Transfer Type field, click Supervise Transfer.

In the Rings to Wait For field, enter 3.
Click Save.
Minimize the Cisco Unity Connection Administration window.

Do not close the Cisco Unity Connection Administration window because you will use it again in a later
procedure.

To Test Supervised Transfer

From Phone 2, enter the access code necessary to get an outside line, then enter the number outside
callers use to dial directly to Cisco Unity Connection.

On the Port Status Monitor, note which port handles this call.

When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting
means that the port is configured correctly.

Confirm that Phone 1 rings and that you do not hear a ringback tone on Phone 2. Instead, you should
hear the indication your phone system uses to mean that the call is on hold (for example, music).

Leaving Phone 1 unanswered, confirm that the state of the port handling the call remains “Busy.” This
state and hearing an indication that you are on hold mean that Cisco Unity Connection is supervising the
transfer.

Confirm that, after three rings, you hear the greeting for the test user. Hearing the greeting means that
Cisco Unity Connection successfully recalled the supervised-transfer call.

During the greeting, hang up Phone 2.

On the Port Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This
state means that the port was successfully released when the call ended.

Exit the Port Status Monitor.
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To Delete the Test User

Step 1 In Cisco Unity Connection Administration, expand Users, then click Users.
Step2  On the Search Users page, check the check box to the left of the test user.
Step3  Click Delete Selected.

(Multiple Integrations Only) Adding New User Templates

When you create the first phone system integration, this phone system is automatically selected in the
default user template. The users that you add after creating this phone system integration will be assigned
to this phone system by default.

However, for each additional phone system integration that you create, you must add the applicable new
user templates that will assign users to the new phone system. You must add the new templates before
you add new users who will be assigned to the new phone system.

For details on adding new user templates, refer to the “Adding, Changing, or Deleting an Account
Template” chapter in the Cisco Unity Connection User Moves, Adds, and Changes Guide at
http://www.cisco.com/en/US/products/ps6509/prod_maintenance_guides_list.html.

For details on selecting a user template when adding a new user, refer to the applicable chapter for adding
user accounts in the Cisco Unity Connection User Moves, Adds, and Changes Guide at
http://www.cisco.com/en/US/products/ps6509/prod_maintenance_guides_list.html.

Appendix: Documentation and Technical
Assistance

Conventions

The Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2 uses the following

conventions.
Table 20 Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2 Conventions
Convention Description
boldfaced text Boldfaced text is used for:

e Key and button names. (Example: Click OK.)

e Information that you enter. (Example: Enter Administrator in the User

Name box.)

<> Angle brackets are used around parameters for which you supply a value.
(angle brackets) (Example: In the Command Prompt window, enter ping <IP address>.)

Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2
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Note

Obtaining Documentation, Obtaining Support, and Security Guidelines ||

Table 20 Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2 Conventions
Convention Description

- Hyphens separate keys that must be pressed simultaneously. (Example: Press
(hyphen) Ctrl-Alt-Delete.)

> A right angle bracket is used to separate selections that you make:

(right angle

e On menus. (Example: On the Windows Start menu, click Programs >

bracket) Cisco Unified Serviceability > Real-Time Monitoring Tool.)
¢ In the navigation bar of Cisco Unity Connection Administration. (Example:
In Cisco Unity Connection Administration, expand System Settings >
Advanced.)
[x] Square brackets enclose an optional element (keyword or argument). (Example:

(square brackets)

[reg-e164])

[x1y] Square brackets enclosing keywords or arguments separated by a vertical line
(vertical line) indicate an optional choice. (Example: [transport tcp | transport udp])

{x1y} Braces enclosing keywords or arguments separated by a vertical line indicate a
(braces) required choice. (Example: {tcp | udp})

The Mitel SX-2000 PIMG Integration Guide for Cisco Unity Connection 1.2 also uses the following

conventions:

Means reader take note. Notes contain helpful suggestions or references to material not covered in the

document.

Caution

Means reader be careful. In this situation, you might do something that could result in equipment
damage or loss of data.

For descriptions and URLSs of Cisco Unity Connection documentation on Cisco.com, see the Cisco Unity
Connection Documentation Guide. The document is shipped with Cisco Unity Connection and is

available at

http://www.cisco.com/en/US/products/ps6509/products_documentation_roadmaps_list.html.

Obtaining Documentation, Obtaining Support, and Security

Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback,
security guidelines, and also recommended aliases and general Cisco documents, see the monthly
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical

documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
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